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This chapter contains important safety instructions
that you should follow when operating the
instrument and when keeping it in storage. Read
the following before any operation to ensure your
safety and to keep the instrument in best condition.
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Warning: Identifies conditions or practices that
could result in injury or loss of life.
Caution: Identifies conditions or practices that
could result in damage to the instrument or to
other properties.
DANGER: High Voltage

79H

Attention: Refer to the Manual
Protective Conductor Terminal
Earth (ground) Terminal
Safety Guidelines
General
Guidelines
CAUTION

•
•
•
•
•
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Do not place heavy objects on the instrument.
Avoid severe impacts or rough handlings that
may damage the instrument.
Avoid discharges of static electricity onto or
near the instrument.
Do not insert bare wires or metal objects into
the terminals.
Do not apply input voltage more than 42V
peak (30Vrms) to the instrument.

Safety Instructions
•

•

GDS-122 User Manual
Occasionally, however, a temporary conductivity caused by condensation

Do not perform measurements at a power
generating source or building installation site
(see note below).
The instrument should only be disassembled
by a qualified technician.

must be expected.
Pollution degree 3: Conductive pollution occurs, or dry, non-conductive
pollution occurs which becomes conductive due to condensation which

is expected. In such conditions, equipment is normally protected against
exposure to direct sunlight, precipitation, and full wind pressure, but
neither temperature nor humidity is controlled.

(Measurement categories) EN 61010-1:2001 specifies the measurement

categories and their requirements as follows. This instrument falls under
category I. Measurement category IV is for measurement performed at

Storage
environment

the source of low-voltage installation. Measurement category III is for
category II is for measurement performed on the circuits directly
connected to the low voltage installation. Measurement category I is for
measurements performed on circuits not directly connected to Mains.

WARNING

AC Input voltage: 100 to 240V, 50/60Hz

•

The power supply voltage should not fluctuate
more than 10%.
Always use the AC adaptor included in the
package.
Always connect the AC adaptor to the mains
line first, then to the instrument.

•

Cleaning the
instrument

•
•

•

Operation
Environment

•
•
•
•

•

Relative Humidity: < 75%
Temperature: −10°C to 70°C

Power cord for the United Kingdom

When using the instrument in the United Kingdom, make sure the
power cord meets the following safety instructions.

•

•

Location: Indoor

•

measurement performed in the building installation. Measurement

Power Supply

•

NOTE: This lead/appliance must only be wired by competent persons
WARNING: THIS APPLIANCE MUST BE EARTHED
IMPORTANT: The wires in this lead are coloured in accordance with the following code:
Green/ Yellow:

Earth

Blue:

Neutral

Brown:

Live (Phase)

As the colours of the wires in main leads may not correspond with the colours marking identified in
your plug/appliance, proceed as follows:

Disconnect the power cord before cleaning the
instrument.
Use a soft cloth dampened in a solution of mild
detergent and water. Do not spray liquid into
the instrument.
Do not use chemicals or cleaners containing
harsh products such as benzene, toluene,
xylene, and acetone.

The wire which is coloured Green & Yellow must be connected to the Earth terminal marked with the

Location: Indoor, no direct sunlight, dust free,
most non‐conductive pollution (see note below)
Relative Humidity: < 75%
Altitude: < 2000m
Temperature: 0°C to 40°C

Any moulded mains connector that requires removal /replacement must be destroyed by removal of any

letter E or by the earth symbol
coloured Blue or Black.

The wire which is coloured Brown must be connected to the terminal marked with the letter L or P or
coloured Brown or Red.
If in doubt, consult the instructions provided with the equipment or contact the supplier.

This cable/appliance should be protected by a suitably rated and approved HBC mains fuse: refer to the
rating information on the equipment and/or user instructions for details. As a guide, cable of 0.75mm2
should be protected by a 3A or 5A fuse. Larger conductors would normally require 13A types,
depending on the connection method used.

fuse & fuse carrier and disposed of immediately, as a plug with bared wires is hazardous if a engaged in
live socket. Any re-wiring must be carried out in accordance with the information detailed on this label.

(Pollution Degree) EN 61010-1:2001 specifies the pollution degrees and
their requirements as follows. This instrument falls under degree 2.

Pollution refers to “addition of foreign matter, solid, liquid, or gaseous
(ionized gases), that may produce a reduction of dielectric strength or
surface resistivity”.

Pollution degree 1: No pollution or only dry, non-conductive pollution
occurs. The pollution has no influence.
Pollution degree 2: Normally only non-conductive pollution occurs.
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or coloured Green or Green & Yellow.

The wire which is coloured Blue must be connected to the terminal which is marked with the letter N or
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Package Contents

GETTING STARTED
0B

Soft carrying case

GDS‐122

AC‐DC adaptor

Oscilloscope probe x 2 + probe
adjustment tools

1kHz square wave output cable

Multimeter test lead x 2

Extension module for large
current measurement

Extension module for small
capacitance measurement

USB communication cable

CD‐ROM

This chapter gives you an overview of what the
GDS‐122 is about, what items are included in the
package, and how the user manual is organized.
After opening the GDS‐122 package, check the
contents referring to the Package Contents section,
then learn the features and interface reading the
Main Features and Front Panel and Keys Overview
section. The Manual Overview section gives you
an overall picture of what each chapter is about,
helping you directly jump to the relevant location.

Package Contents .................................................... 1 0
80H

Main Features .......................................................... 1 1
81H

(software)

Front Panel and Keys Overview ................................. 1 2
82H

Manual Overview ..................................................... 1 4
83H
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RS‐232C communication cable

(this document)

(optional item – contact Good
Will)

Getting Started

Main Features

Front Panel and Keys Overview

1B

Oscilloscope

•

Dual channel

•

20MHz bandwidth
100MS/s real‐time sampling rate
≤ 17.5ns rising time
5ns to 5s/div horizontal scale
5mV to 5V/div vertical scale
6k memory points per channel
Isolated inputs between oscilloscope and
multimeter
Autoset function
Trigger mode: Auto, Free run, Single shot,
Edge, Video
2 cursors
5 automatic measurements
4 display image memories
Auto‐calibration

•
•
•
•
•
•
•
•
•
•
•
•

Multimeter

•
•
•
•

Common

2B

Display
contrast
switch

•

MENU key +
Up/Down keys

A switch
V switch

RUN/STOP key
AUTOSET key
DMM/OSC key

R switch
mA
terminal

Volts, Amps, Ohms, Continuity, Diode,
Capacitance measurement
20A maximum amplitude
True RMS measurement
Isolated inputs between oscilloscope and
multimeter

Oscilloscope
CH1/CH2
terminal
COM
V/Ohm
CX
terminal terminal terminal

DSO

: Oscilloscope function

: Multimeter function

DMM

AC adaptor plug Accepts the AC adaptor cord. DC 8.5V, 1500mA.

RS‐232C interface
1kHz square wave output
3.8 inch color LCD display, 320 x 240 resolution
6 hours running time Li‐ion battery
180mm x 113mm x 40mm compact size
690g light weight

•

OSC OPTION key
+ Arrow keys

Power
switch

•

•

LCD
display

F1 - F5 keys

USB interface

•

USB/RS-232C/Square wave port

AC adaptor
plug

•

•

GDS-122 User Manual

USB port

Accepts the USB cable for PC connection.

RS-232C port

Accepts the optional RS‐232C cable for PC
connection.

Square wave
output

Outputs a 1kHz square wave for probe
compensation and other general purposes.

LCD display

3.8 inch, 320 x 240 resolution, color LCD display.

OSC OPTION key
+ Arrow keys

DSO

Sets the following parameters: vertical
level and scale (page22), horizontal level
and scale (page25), trigger level (page25),
and cursor position (page42).
84H

85H

86H

87H
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MENU key +
Up/Down keys

DSO

RUN/STOP key

DSO
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Manual Overview

Activates the side menu and selects the
menu items.
3B

Manually turns on (run) or off (stop) the
trigger. For details, see page25.

Overview

This user manual is comprised of seven chapters.
If you want to jump start using the GDS‐122, go
directly to the Using Oscilloscope or Using
Multimeter chapter.

Safety
Instructions
(page6)

The Safety Instructions gives you an overview of
important safety‐related issues which you should
be aware of before, during, and after operations.

Getting Started
(page9)

The Getting Started chapter provides you with the
overview of the GDS‐122: main features, package
contents, front panel, and user manual (this
section).

Using the
Oscilloscope
(page15)

The Using the Oscilloscope chapter describes in
detail how to use the GDS‐122’s oscilloscope
functionalities, including the PC software. The
chapter starts with simple, basic operations
toward more complex measurements and settings.
If you are new to the GDS‐122, start with the Basic
Operations section. For advanced users, the Menu
Tree / Shortcuts section shows the menu structures
and all operations shortcuts.

Using the
Multimeter
(page83)

The Using the Multimeter chapter describes how to
use the GDS‐122’s multimeter functionalities. The
most commonly used Voltage, Current, and
Resistance sections are listed in the front.

Faq

8H

RUN/STOP key

DMM

Freezes (stop) or unfreezes (run) the
measurement.

AUTOSET key

DSO

Automatically selects the horizontal scale,
vertical scale, and trigger level according
to the input signal. See page18 for details.

9H

89H

DMM

Switches the measurement mode. For
details, see page87(current),
page85(voltage), and page89(impedance).

10H

90H

91H

DMM/OSC key

92H

Switches the operation mode between the
oscilloscope and multimeter.

CH1/2 terminal

DSO

Accepts the CH1 and CH2 input signal.

CX terminal

DMM

Accepts the test leads for capacitor
measurement.

V/Ω terminal

DMM

Accepts the red lead for voltage, small
capacitance, and impedance
measurements.

COM terminal

DMM

Accepts the black (ground) lead.

mA terminal

DMM

Accepts the red lead for current
measurement.

R switch

DMM

Selects the following measurement:
impedance (page89), diode (page91),
continuity (page92), capacitance (page93).

(page95)

The Faq chapter lists major problems you might
encounter during operations and how to fix or
avoid them. Most issues are also listed in the
relevant chapters throughout the document.

Selects voltage measurements (page85).

Specifications
(page97)

The GDS‐122 specifications are separated in
oscilloscope, multimeter, and general parts.

Declaration of
conformity
(page100)

The Declaration of Conformity chapter lists the
safety and EMI/EMC standards to which the GDS‐
122 conforms.

Index

The Index chapter lists most of the keywords used
in this manual in an alphabetical order.

10H

102H

93H

95H

V switch

DMM

103H

94H

96H

97H

104H

A switch

DMM

Selects current measurements (page87).
98H

Power switch

Turns on or off the GDS‐122 power.

F1 – F5 keys

Selects the menu item at the bottom of the display.

105H

Disp contrast sw Selects the display contrast.

(page101)
106H
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Basic Operations

USING THE
4B

Operation flow

The Basic Operations section describes how to set
up the GDS‐122 and observe an input signal, step‐
by‐step.
1. Powering up the GDS‐122
2. Connecting an input signal
3. Using the Autoset / Introducting the display
4. Adjusting the scales
5. Adjusting the waveform position

Advanced
operations

For more advanced or detailed operations, see the
following chapters.
• Configurations (page22)
• Measurements (page39)
• Advanced Viewings (page45)
• Calibrations (page51)

OSCILLOSCOPE
This chapter describes the oscilloscope
functionalities in the GDS‐122: setting it up and
measuring simple waveforms, using advanced
measurement functions, and configuring the
system settings. The menu tree section at the end
gives you an overview of all functionalities and a
quick access to each of them. For the multimeter
functionalities, see page83.

16H

17H

107H

18H

Basic Operations ...................................................... 1 6
108H

19H

Configurations ........................................................ 2 2
109H

Measurements ......................................................... 3 9
10H

Advanced Viewings .................................................. 4 5
1H

Calibration .............................................................. 5 1
12H

1. Powering up the GDS-122
19B

1. Pressing the
power switch

Saving/Recalling Waves and Settings ......................... 5 3

Press the power switch. The welcome
screen with the corporate logo
appears on the display.

13H

Menu Tree / Operation Shortcuts .............................. 5 6
14H

Using the Software................................................... 6 1
15H

Press any key to continue.

To adjust the display brightness, press
the switch on the side. The backlight
turns on and off.
2. Activating the Press any key (for example the MENU (Example)
oscilloscope key) to enter the oscilloscope mode.

See the battery level icon at the top left
corner of the display and connect the

15
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75%

50%

25%

< 25%

X10

CH2

Switching the
If the multimeter screen appears,
operation mode press the DMM/OSC key and change

DMM/OSC

the mode to oscilloscope.

X1

X1

CAT II
400V

> 75%

CH1

power cord if the level is < 25%.
X10

X10

DUT or
1kHz square
wave

X1

3. Setting the
1. After attenuating the probe level by x10, you
display
also need to magnify the display level by x10
magnification
to match the displayed amplitude with the real

Tilt standing the Use the bar at the back to
GDS-122
tilt stand the GDS‐122 on a

horizontal plane.

amplitude. Open the CH1 or CH2 SETUP
menu by pressing the MENU key and using
the Up/Down keys.

2. Select the probe attenuation level (10X) by
pressing F3 (Probe) repeatedly. The CH1/CH2
vertical scale indicator at the bottom left corner
of the display changes accordingly.
Note

If pressing the power switch does not turn on the
GDS‐122, the battery may need recharging.
Connect the GDS‐122 to the AC adaptor and
recharge it for at least 15 minutes.

MENU

CH1 SETUP
CH2 SETUP

10 X
Probe

2. Connecting an input signal

F3

3. Using the Autoset function

20B

21B

1. Connecting
the probe

Connect the probe(s) between the DUT (Device
Under Test) and the CH1/2 inputs on the GDS‐122.

Overview

Alternately, you may use the
GDS‐122’s own 1kHz square
wave output signal. Insert the
signal cable (included in the
package) to the output terminal.
2. Setting the
probe
attenuation

To prevent excessive input voltage, we
recommend you to set the probe attenuation level
to the X 10 position to prevent excessive voltage.

The Autoset function automatically configures the
following parameters according to the input
signal.
• CH1/CH2 on/off
• Vertical scale/level
• Horizontal scale/level
• Trigger level

Using the
Press the AUTOSET key. The input
Autoset function signal appears in the best display

condition.

(Continued on next page)
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5. Adjusting waveform scales

Example
23B

Before

Selecting the
menu

After

Vertical scale

4. Introducing the display contents
2B

Frequency /
channel off

Trigger status

OSC
OPTION

Horizontal scale

Use the Left/Right key to change the horizontal
Adjusting the
horizontal scale scale.
Original

Horizontal
center
position
Trigger level

Vertical
center
position

Horizontal
scale
Vertical
center
position

Vertical scale

Trigger status

Press the OSC OPTION key
repeatedly until the following
menu appears on the display.
– Time Base
– CH1 (or CH2) Volts/Div

•

Updating the signal (auto mode)

•

The signal is triggered
Waiting for trigger conditions
Triggering is stopped

•
•

Press the RUN/STOP key to control
trigger on/off (run/stop).

Adjusting the
vertical scale

AUTO
Trig’d
Ready
STOP

RUN/STOP

19
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Use the Up/Down key to change the vertical scale.
Original
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Configurations

6. Adjusting waveform positions
5B

24B

Selecting the
menu

Press the OSC OPTION key
repeatedly until the following
menu appears on the display.
– Time
– CH1 (or CH2) Zero

Overview

The configuration chapter describes how to
change various GDS‐122 internal parameters for
allowing better measurement condition.

Configuration
items

•

OSC
OPTION

•
•

Horizontal
center
position

•
•
•

Vertical
center
position

page22
page25
page25
page30
page36
page37
120H

12H

12H

123H

124H

125H

Configuring channel (vertical) settings
25B

Overview

Adjusting the
horizontal
position

Channel (vertical) settings
Horizontal settings
Trigger settings
Acquisition modes
Display settings
System status (only for viewing)

Use the Left/Right key to change the horizontal
position.
Original

The channel settings configure how the waveform
appears in terms of vertical or voltage scale.
Position

Sets the vertical position of the
waveform.

Scale

Sets the vertical scale (volts per
graticule). Range: 5mV/div to 5V/div

CH on/off Turns the channel on or off.
Coupling Selects AC or DC coupling. The DC
coupling shows all signal elements,
while the AC coupling filters out the
DC component from the waveform.

Adjusting the
Use the Up/Down key to change the vertical
vertical position position.

Inversion Flips the waveform upside down.
Magnifica Magnifies the displayed units (does not
‐tion
magnify the real signal). The
magnification function is useful to
align the displayed with probe
attenuation (page17), especially X10.

Original

126H

21

22

Using the Oscilloscope
Setting the
1. Press the OSC OPTION key
vertical position
repeatedly until the following

menu appears on the display.
– Time
– CH1 (or CH2) Zero

GDS-122 User Manual

OSC
OPTION

MENU

CH1 SETUP
CH2 SETUP

OFF
ON
Channel
F2

Note that when using the Autoset function
(page18), channels are automatically turned on or
off.
127H

2. Use the Up/Down key to change the vertical
position.

Selecting the
coupling mode

Original

1. Press the MENU key and use the Up/Down
keys to select the CH1(CH2) SETUP menu.
2. Press F1 (Coupling) repeatedly to select DC,
AC, or Ground coupling.

MENU

Setting the
vertical scale

1. Press the OSC OPTION key
repeatedly until the following
menu appears on the display.
– Time Base
– CH1 (or 2) Volts/Div

OSC
OPTION

CH1 SETUP
CH2 SETUP

DC
Ground
AC
Coupling
F1

The DC coupling shows both DC and AC
signal.
The AC coupling only shows the AC signal.
The Ground coupling shows the ground line.
DC coupling

(center point is at the
bottom due to DC
offset)

2. Use the Up/Down key to change the vertical
scale.
Original

AC coupling
Turning the
channel on/off

1. Press the MENU key and use the Up/Down
keys to select the CH1(CH2) SETUP menu.
2. Press F2 (Channel) repeatedly to turn on or off
the channel.

23

(center point is at the
middle since the DC
offset is being
removed)
Inverting the
channel

24

1. Press the MENU key and use the Up/Down
keys to select the CH1(CH2) SETUP menu.
2. Press F4 (Inverted) to invert the waveform.

Using the Oscilloscope

MENU

CH1 SETUP
CH2 SETUP

Invert off

Selecting the
magnification

ON
OFF
Inverted

2. Use the Left/Right key to change the horizontal
position.

F4

Invert on

Original

1. Press the MENU key and use the Up/Down
keys to select the CH1(CH2) SETUP menu.
2. Press F3 (Probe) repeatedly to select the probe
magnification ratio.

MENU

GDS-122 User Manual

CH1 SETUP
CH2 SETUP

Selecting the
1. Press the OSC OPTION key
horizontal scale
repeatedly until the following

menu appears on the display.
– Time Base

1000 X
100 X
10 X

2. Use the Left/Right key to change the horizontal
scale.

1X
Probe

Original

F3

Configuring horizontal settings
26B

Overview

Setting the
horizontal
position

The horizontal settings configure how the
waveform appears in terms of horizontal or time
scale.
Position

Sets the horizontal position of the
waveform.

Scale

Sets the horizontal scale (time per
graticule). Range: 100ms/s to 10s/s

1. Press the OSC OPTION key
repeatedly until the following
menu appears on the display.
– Time

OSC
OPTION

OSC
OPTION

25
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triggering, you have to press the
RUN/STOP key again (in single trigger
mode) or switch to another trigger mode.

Configuring trigger settings: general settings
27B

Overview

The trigger settings configure how the incoming
signal is triggered. The general settings section
describes how to start and stop triggering, adjust
the level, and change the trigger mode.
• For edge triggering details, see page30.
• For video triggering details, see page33.

Horizontal scale vs. trigger status
5ns/div

100ms/div

5s/div

Trig’d

128H

AUTO

Scan

129H

Status

Trigger status

Ready

Shows the triggering status in the icon
appearing in the upper right corner of
the display.

Run/Stop

Controls starting and stopping the
trigger.

Level

Adjusts the vertical and horizontal
level on which the waveforms are
triggered.

STOP

Run/Stop

RUN/STOP
STOP

In the single trigger mode in edge triggering
(page30), pressing the RUN/STOP key works as
both activating and deactivating trigger.
132H

The trigger status icon is located at the top right
corner of the display.
Trig’d

The trigger condition is met.

AUTO

The GDS‐122 is showing the input signal
waveform regardless of trigger
condition. Available in the Auto trigger
mode in edge triggering (page30).

Trigger level

Press the OSC OPTION key
repeatedly until the following menu
appears on the display.

OSC
OPTION

– Time
– Trig
Trigger level indicators

130H

Ready

Pressing the Run/Stop key once stops
triggering at most situations and
changes the trigger icon to STOP.

Trigger level
(horizontal)

The trigger condition is not met, and the
GDS‐122 is waiting for the next
condition. Available in the Normal
trigger mode in edge triggering (page30).
13H

Scan

STOP

The GDS‐122 is showing the input signal
waveform regardless of trigger
condition. The waveform is gradually
updated from the left side of the display.
The GDS‐122 automatically switches to
the Scan when the horizontal scale is at
100ms/div or longer.

Trigger level
(vertical)

Triggering is stopped regardless of the
trigger condition. In order to restart
27

28

Using the Oscilloscope
Use the arrow keys to change the triggering
position.

Configuring trigger settings: edge triggering
28B

Move the trigger
point up
Move the
trigger point
left

GDS-122 User Manual

Overview
Move the
trigger point
right

The edge trigger type triggers on the incoming
signal edge. Use the edge trigger for all signals
except for video related ones.
• For general trigger settings, see page27.
• For video triggering details, see page33.
13H

134H

Move the trigger
point down

To select edge triggering, follow these steps.
1. Press the MENU key and use the Up/Down
keys to select TRIG MODE menu.
2. Press F1 (Type) to select the Edge trigger type.

Pressing the Up and Down
key together resets the
vertical trigger level to zero.

MENU

Pressing the Left and Right
key together resets the
horizontal trigger level to
zero.

TRIG MODE

Edge
TYPE
F1

Selecting the
trigger slope

Slope

Selects the slope, rising or falling, on
which the GDS‐122 triggers the input
signals.

Source

Selects the signal source channel,
CH1 or CH2.

Mode

Selects the triggering mode, Auto
(acquires signal continuously),
Normal (acquires signal when trigger
conditions are met), and Single
(manually triggers the signal).

Coupling

Selects the DC or AC coupling and
rejection filters: high frequency or
low frequency.

Press F2 (Slope) repeatedly to
select the rising or falling slope.

Rising
Falling
Slope
F2

(Continues to the next page)
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Normal mode

Example: falling edge
Falling edge

In the normal mode, input signals are shown in
the display only if the trigger condition is met.

Triggering point

Horizontal scale (/div)

5ns

100ms

5s

Status icon when triggered

Trig’d

Scan

Status icon when not triggered

Ready

Scan

Single mode

In the single mode, you manually trigger the GDS‐
122 by pressing the RUN/STOP key each time you
need to observe the waveform. Once the waveform
is captured, the GDS‐122 stops triggering and
waits for the next trigger command.
Selecting the
source channel

Horizontal scale (/div)

CH2

Press F3 (Channel) repeatedly to select
the trigger source channel, CH1 or
CH2. The trigger channel indicator at
the bottom right corner of the display
changes.

5ns

Status icon when triggered

CH1
Source
F3

Status icon when not triggered

100ms
STOP

5s

STOP

AUTO
Scan
Ready

Trigger source
channel

Selecting the
trigger mode

Selecting the
coupling mode
Auto
Normal

Press F4 (Mode) repeatedly to select
the trigger mode. The trigger status
icon in the upper right corner of the
display changes accordingly. For the
overview of trigger status in general,
see page27.

Single
Mode
F4

135H

Auto mode

In the auto mode, input signals are constantly
acquired and shown in the display regardless of
trigger condition.
Horizontal scale (/div)

5ns

100ms

Status icon when triggered

Trig’d

Scan

Status icon when not triggered

AUTO

Scan

5s

31
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Press F5 (Coupling) repeatedly to select
the trigger coupling.
• AC: triggers only on the AC portion
of the waveform.
• DC: triggers on the whole waveform
(AC + DC).
• LF Rjc: filters out the lower
frequency when triggering.
• HF Rjc: filters out the higher
frequency when triggering.

AC
LF Rjc
HF Rjc
DC
Coupling
F5
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Configuring trigger settings: video triggering
29B

Overview

The video trigger type is designed to capture the
video signal format, NTSC, PAL, or SECAM. For
any other signal type, use the edge trigger.
• For general trigger settings, see page27.
• For edge triggering details, see page30.

GDS-122 User Manual

Selecting the
source channel

Press F3 (Channel) repeatedly to select
the trigger source channel, CH1 or
CH2. The trigger channel indicator at
the bottom right corner of the display
changes.

CH2
CH1
Source
F3

136H

Trigger source
channel

137H

To select edge triggering, follow these steps.
1. Press the MENU key and use the Up/Down
keys to select TRIG MODE menu.
2. Press F1 (Type) to select the video trigger type.

MENU

TRIG MODE

Video
TYPE

Polarity

Selects the polarity of
synchronization signal. Normal
means the black level is low. Invert
means the black level is high.

Source

Selects the signal source channel,
CH1 or CH2.

Sync

Selects the part of the video signal
used for synchronization: line or
field.

Press F2 (Polarity) repeatedly to select
the polarity of synchronization signal.
• Normal: the black level is low.
• Inverted: the black level is high.

Press F4 (Polarity) repeatedly to select
the synchronization point.
• Line: the video line is used for
triggering.
• Field: the video field is used for
triggering.

Example

F1

Selecting the
trigger polarity

Selecting the
sync

Video line trigger

Inverted
Normal
Polarity
F2

(Continues to the next page)
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Video field trigger

Field
Line
Sync
F4
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Selecting the acquisition mode

Configuring display settings

30B

Overview

31B

The acquisition mode specifies how the incoming
analog signal is digitally sampled by the GDS‐122.
Sample

Peak detect

Average

GDS-122 User Manual

Overview

vector drawing The vector drawing mode shows

The waveform data is sampled at an
equal time interval. The sample
mode accurately reconstructs the
waveform, but cannot respond to
rapid changes and sudden peaks.

the waveform as a smooth line,
connecting each data point.

The maximum and minimum data
in the sampling interval are picked
up. The peak detect mode captures
rapid changes and sudden peaks,
but the waveform becomes noisy.
Multiple samples are averaged
together. The average mode reduces
the noise level, but the waveform
must be repetitive. The number of
averaging are 4, 16, 64, and 128.

2. Select the acquisi‐
tion mode from F1
(Sample) to F3
(Average).

Sample

persistence

The persistence setting sets how
long the old waveforms remain in
the display, useful for observing
the waveform variations.

keys to select the DISP SET menu.
2. Press F1 (Type) or F2 (Persist) repeatedly to
select vector drawing, dot drawing, and
persistence time.

MENU
Peak
Detect

Average

F1

F2

F3

Peak detect

The dot drawing mode shows the
waveform as a collection of
independent data points.

ACQU MODE

Sample

For the Average mode, also
press F4 (Averages) repeatedly
to select the number of
averaging: 4, 16, 64, or 128.
Example

MENU

dot drawing

Panel operations 1. Press the MENU key and use the Up/Down

Panel operations 1. Press the MENU key and

select the ACQU MODE
menu using the Up/Down
keys.

The display settings configure how the waveforms
are drawn in the display.

Vector/dot
drawing example

DISP SET

Dots

Infinite
1/2/5 sec

Vectors
Type

OFF
Persist

F1

F2

Vector

Dot

Persistence off

Persistence infinite

16
Averages
F4

Persistence
example

Average (16)
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Viewing the system status

Vertical status (F2)

32B

Overview

The system status menu shows the GDS‐122
system settings.

VERTICAL SYSTEM STATUS

Panel operations 1. Press the MENU key and

select the SYS STAT menu
using the Up/Down keys.

SYS STAT

MENU

2. Select the status menu from F1 (Horizontal) to
F4 (Misc) and press it. The status information
appears in the display.
Horizontal Vertical

F1

GDS-122 User Manual

F2

Trigger

Misc

F3

F4

3. To close the system status
screen, select different menus
using the MENU key
followed by Up/Down keys.

SCALE
SCALE
POSITION
POSITION
COUPLING
COUPLING
PROBE
PROBE
MATH
INVERTED
INVERTED

CH1
CH2
CH1
CH2
CH1
CH2
CH1
CH2
CH1-CH2
CH1
CH2

2.00v
50.0mv
0.00 divs(0.0mv)
0.00 divs(0.0mv)
DC
DC
1X
1X
OFF
OFF

For details of each item, see the
following pages.
CH1/CH2 scale: page22
CH1/CH2 position: page22
CH1/CH2 coupling: page22
CH1/CH2 probe: page22
Math mode: page39
CH1/CH2 invert: page22
143H

14H

145H

146H

147H

148H

Trigger status (F3): Edge trigger
TRIGGER SYSTEM STATUS
TYPE
SOURCE
SLOPE
TRIGMODE
COUPLING

EDGE
CH1
RISING
SINGLE TRIGGER
DC

MENU

For details of each item, see the
following pages.
Trigger type: page30
Trigger source: page30
Trigger slope: page30
Trigger mode: page30
Trigger coupling: page30
149H

150H

15H

152H

153H

Horizontal status (F1)
HORIZONTAL SYSTEM STATUS
TIME BASE
MAIN SCALE
WINDOW SCALE
MAIN POSITION
WINDOW POSITION
DISPLAY FORMAT
ACQUIRE MODE

MAIN TIME BASE
1.0ms
10.us
300.0us
559.60us
YT
SAMPLE

Trigger status (F3): Video trigger

For details of each item, see the
following pages.
Time base: page25
Main/window scale: page45
Main/window position: page45
Display format: page47 (XY)
Acquire mode: page35
138H

139H

TRIGGER SYSTEM STATUS
TYPE
SOURCE
POLARITY
SYNC

VIDEO
CH1
NORMAL
LINE

140H

Misc status (F4)

Series Number
0739002
Ver 3.0

37

15H

157H

MISC

(Continues to the next page)

154H

156H

14H

142H

For details of each item, see the
following pages.
Trigger type: page33
Trigger source: page33
Trigger polarity: page33
Trigger sync: page33

38

The Misc status shows the serial
number and firmware version.
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Measurements
6B

Overview

The advanced measurement functions allow you
to automatically measure various parameters in a
waveform.

Measurement
items

•
•
•
•

Waveform math
Automatic measurements
Time cursor measurement
Voltage cursor measurement

page39
page41
page42
page43
158H

159H

160H

16H

Running waveform maths

5. To cancel the math result, press the function
key (F1 to F5) again.

3B

Overview

The waveform math function runs mathematical
operations between CH1 and CH2 waveform, and
then shows the result in the display.

Math type

•

CH1 – CH2 (subtract CH2 from CH1)

•

CH2 – CH1 (subtract CH1 from CH2)
CH1 + CH2 (add CH1 and CH2)
CH1 * CH2 (multiply CH1 and CH2)
CH1 / CH2 (divide CH1 by CH2)

•
•
•

Changing the
math result
position

1. Press the OSC OPTION key.
Make sure the following menu
appears on the display.

OSC
OPTION

– Time
– CHM Zero

2. Use the arrow keys to move the
math result position.

Panel operations 1. Make sure that both CH1 and CH2 waveforms

are shown in the display.

1. Press the OSC OPTION key
Changing the
repeatedly until the following
math result scale

2. Press the MENU key and
select the WAVE MATH menu
using the Up/Down keys.

MENU

OSC
OPTION

menu appears on the display.

WAVE MATH

– Time Base
– CHMath
Volts/Div

3. Select the math operation from F1 (CH1 –
CH2) to F5 (CH1 / CH2) and press it.

2. Use the arrow keys to change
the math result scale.

CH1-CH2 CH2-CH1 CH1+CH2 CH1*CH2 CH1/CH2
F1

F2

F3

F4

F5

Saving or
recalling the
math result

4. The math result appears in the display
(example: adding two square waveforms)

39

40

The math result waveform can be saved into or
recalled from one of the four GDS‐122 internal
memories. See page53 for details.
162H
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F5 (Cyc). Press it repeatedly to select CH1 or 2.

Running automatic measurements

Top left
corner

34B

Overview

Source signal

The automatic measurement function measures
the input signal’s characteristics and lists them in
the top left corner of the display.
CH1, CH2

The following measurement items are available.
•
•
•
•
•

Frequency
Period
Mean voltage
Peak‐to‐peak voltage
Cycle voltage (true RMS)

V

Vp

Vk

Freq

Period

Mean

PK-PK

Cyc RMS

F1

F2

F3

F4

F5

2. Press the MENU key and
select the MEAS SET1 or
SET2 menu using the
Up/Down keys. SET1 and
SET2 correspond to the
results in the upper left
corner of the display.

Running time cursor measurements
35B

Overview

Panel operations 1. Make sure that the waveform appears.

MEAS SET1

T

4. The measurement result appears in the top left
corner of the display.

Measurement set SET1, SET2
Measurement
items

f

MENU

The time cursor function measures and updates
the following three types of time difference.
• Between cursor 1 and cursor 2
• Between cursor 1 and center (zero) point
• Between cursor 2 and center (zero) point

1. Make sure that the waveform appears.
Time cursor
panel operations
2. Press the MENU key and
select the CURS MEAS menu
using the Up/Down keys.

MEAS SET1
MEAS SET2

MEAS SET2

MEAS SET1
MEAS SET2

MENU

3. Press F1 (Type) repeatedly to
select the Time cursor. The
cursors appear as vertical
purple lines located at the
center of the display.

Time
Type

4. Press the OSC OPTION key
repeatedly until the following
menu appears.

OSC
OPTION

CURS MEAS

F1

– Time
– Cursor 1(or 2)

5. Use the arrow keys to move the cursor or
horizontal position.
Measurement items

3. Select the measurement type from F1 (Freq) to
41

42
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Move the
cursor left
Move the
horizontal
position left

Move the
horizontal
position right
Move the
cursor right

(CH1, cursor 2)

Voltage
Type

4. Press F2 (Source) repeatedly
to select the source channel.

CH1
Source

F1

F2

T2
T1 T0
Cursor (center) Cursor

Display overview

3. Press F1 (Type) repeatedly to
select the Voltage cursor. The
cursors appear as horizontal
purple lines located at the
center of the display.

5. Press the OSC OPTION key
repeatedly until the following
menu appears.

OSC
OPTION

– Time
– Cursor V1 (or V2)

T2 - T0 time
T1 - T0 time
T1 - T2 time
& frequency
Cursor menu

6. Use the arrow keys to move the cursor or
horizontal position.
Move the
cursor up
Move the
horizontal
position right

Running voltage cursor measurements
36B

Overview

Source signal

The voltage cursor function measures and updates
the following five types of voltage difference.
• Between cursor 1 and cursor 2
• Between cursor 1 and CH1 center point
• Between cursor 2 and CH1 center point
• Between cursor 1 and CH2 center point
• Between cursor 2 and CH2 center point

Move the
cursor down

V1
Cursor

Display overview
(CH1, cursor 2)

CH1 input, CH2 input
V2 - center
V1 - center
|V1 - V2|
Cursor menu

1. Make sure the waveform appears.
Voltage cursor
panel operations
2. Press the MENU key and
select the CURS MEAS menu
using the Up/Down keys.

MENU

CURS MEAS

43

Move the
horizontal
position left

OSC
OPTION

44

V2
Cursor
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Advanced Viewings

4. Press the OSC OPTION key
repeatedly until the Time
Base menu appears.

7B

Overview

Viewing items

The advanced viewing functions allow you to
clearly observe specific type of waveforms and/or
particular characteristics in a waveform.
•
•
•
•
•

Waveform zoom
X‐Y format
Signal peaks
Noisy signals
Variations in a signal

OSC
OPTION

– Time
– Cursor V1
(or Cursor V2)

page45
page47
page48
page48
page49
163H

5. Use the arrow keys to change the zoom width.

164H

Zoom out
vertical scale

165H

16H

167H

Narrow range

Zooming waveforms horizontally

OSC
OPTION

Wide range

37B

Overview

Zoom in
vertical scale

By using the zoom function, you can magnify the
waveform in the horizontal direction.

6. Press F3 (Window) to zoom
into the window.

Panel operations 1. Make sure that the waveform appears in the

display.

2. Press the MENU key and
select the TIME MODE menu
using the Up/Down keys.

3. Press F2 (Set Window). A set
of cursors appears in the
center of the display.

Window
F3

MENU

TIME MODE

Example

Zone
Window
F2

Zoom window

45

46
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Viewing waveforms in X-Y format

Viewing signal peaks

38B

Overview

39B

The X‐Y format plots the CH1 input as X‐axis and
CH2 input as Y‐axis. This display mode is
convenient for viewing the phase relationship
between CH1 and CH2.

Panel operations 1. Make sure that both CH1 and CH2 waveforms

appear in the display.

2. Press the MENU key and
select the DISP SET menu
using the Up/Down keys.

DISP SET

MENU

CH1 Zero: horizontal position

•

CH2 Zero: vertical position
CH1 Vol: horizontal scale
CH2 Vol: vertical scale

•
•

Using the peak detect acquisition mode, the
maximum and minimum data in the sampling
interval are displayed, capturing the rapid
changes and sudden peaks that might
spontaneously occur in a waveform.

Note

Since the peak detect mode picks up the most
extreme data, the waveform becomes noisier than
the normal acquisition mode (sampling mode).

Panel operations 1. Press the MENU key and use the Up/Down

keys to select ACQU MODE menu.
2. Press F2 (Peak Detect) to activate the peak
detect mode.

F3
MENU

Press the OSC OPTION key
repeatedly to access the menu listed
below. In the X‐Y mode, all scales and
positions are controlled by the
Up/Down keys.
•

Overview

XY
Format

3. Press F3 (Format) and select
XY. The display mode
switches into the X‐Y format.
Changing the
scale and
position

GDS-122 User Manual

For other acquisition settings details, see page30.
173H

Example

Functions not
The following functions do not work in the X‐Y
applicable in the format.
X-Y format
• Cursor measurement (page42, page43)
•
•
•

Peak
Detect
F2

OSC
OPTION

Peak detect off

168H

ACQU MODE

169H

Automatic measurement (page41)
Window zoom (page45)
Trigger settings configuration (page25)
170H

17H

172H

47

48

Peak detect on
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Viewing noisy signals

Viewing variations in a signal

40B

41B

Overview

Using the Average acquisition mode, you can
smooth out the displayed waveform by averaging
multiple data samples. The number of averaging is
selectable from 4, 16, 64, and 128.

Note

•
•

GDS-122 User Manual

In order for the average mode to work in the
best way, the waveform must be repetitive.
As the number of averaging increases, the
slower the waveform update becomes.

Overview

Panel operations 1. Press the MENU key and use the Up/Down

keys to select DISP SET menu.
2. Press F2 (Persist) repeatedly to select the
persistence time.

Panel operations 1. Press the MENU key and use the Up/Down

keys to select ACQU MODE menu.
2. Press F3 (Average) to activate the average
mode.
3. Press F4 (Averages) repeatedly to select the
number of averaging.

Infinite
1/2/5 sec
MENU

ACQU MODE

Average

16
Averages

F3

F4

OFF
Persist

For other display settings details, see page36.
175H

Example
Persistence off

For other acquisition settings details, see page30.
174H

Example
Average off

DISP SET

F2

4
128
64
MENU

Using the persistence display function, you can
define sets how long the old waveforms remain in
the display, allowing observation of waveform
variations. You can select the persistence time
from 1, 2, and 5 sec. When choosing the Infinite
mode, the GDS‐122 keeps all past traces of the
displayed waveform.

Average 16

49

50

Persistence infinite
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Running the probe calibration

Calibration
43B

8B

Overview

The self calibration automatically adjusts the GDS‐
122 internal parameters. The probe calibration
adjusts the probe capacitance. You should run
both whenever using the GDS‐122 in a new
environment.

Overview

The attached probe contains a calibration point at
the end to adjust the waveform.

Procedure

1. You may use the GDS‐122’s own
1kHz square wave output
signal. Insert the signal cable
(included in the package) to the
output terminal.

Running the self calibration
42B

Overview

The self calibration function automatically
configures internal parameters to maintain the
sensitivity and accuracy. Run the self calibration in
the following cases.
• When the temperature fluctuates more than 5
degrees Celsius during operations
• When operating the GDS‐122 in a new
benchtop or field environment

Procedure

1. Press the MENU key and
select the FUNCTION menu
using the Up/Down keys.

MENU

2. Use the Autoset function to put
the waveform in the middle of
the display.

FUNCTION

2. Press F2 (Autocalibration). A
message appears on the
display, asking you to remove
all cables and probes from the
GDS‐122.

Autocalibration

3. After removing all cables,
press F2 (Autocalibration)
again. The self‐calibration
automatically starts and a
message appears, showing
that the calibration is
ongoing.

Autocalibration

3. Adjust the probe calibration point to make sure
that the waveform edge remains flat.

F2

F2

Overcompensation

4. When the message disappears in 5 minutes, the
calibration is completed.
To interrupt
calibration

AUTOSET

Press any key during the calibration.

51

52

Optimum

Undercompensation
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Saving waveforms

9B

Overview

45B

The GDS‐122 can save or recall four sets of
waveforms using its internal memory. When you
need to reset the system, recall the default (factory
installed) settings.

Save/recall items •
•
•

Overview

Up to four waveforms can be stored in and
recalled from the GDS‐122 internal memory. The
stored waveform can be used for reference,
comparison, or analysis.

Recalling default settings

page53

Memory

Four memories: waveform A, B, C, and D.

Saving waveforms
Recalling waveforms

page54
page55

Source

CH1, CH2, Math waveform

176H

17H

178H

Panel operations 1. Make sure the waveform you want to save

(CH1, CH2, or Math result) appears in the
display.
For Math operations details, see page39.

Recalling the default settings
4B

Recalling the
default settings

179H

You can recall the default factory settings by
pressing the MENU key, then selecting
FUNCTION → F1 (Recall Factory).

MENU

FUNCTION

2. Press the MENU key and
select the WAVE SAVE menu
using the Up/Down keys.

Recall
Factory
F1

Trigger

Type: Edge
Source: CH1
Coupling: AC
Coupling: AC
CH1 & CH2
Probe scaling: 1 X
Measurement 1 Item: CH1 frequency
Measurement 2 Item: CH2 frequency

Slope: Rising
Mode: Auto

Cursor

Cursor: OFF

Channel: CH1

Acquisition

Mode: Sample

Average number: 16

Time mode

Mode: Main timebase

Display

Type: Vector
Format: YT
Source: CH1
Display: OFF

Wave Save

Channel: ON
Invert: OFF

Persistence: OFF
Carry: Bitmap
Waveform: A

53

54

MENU

3. Press F1 (Source) repeatedly
and select the waveform
source.

CH1
Source

4. Press F2 (WAVE) repeatedly
and select the memory
location from A to D.

A
Wave

5. Press F3 (Save) to confirm
saving the waveform into the
specified memory location.
Make sure that the message
“WAVE SAVED” appears in
the display.

Save

WAVE SAVE

F1

F2

F3
WAVE SAVED

Using the Oscilloscope
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Menu Tree / Operation Shortcuts

Recalling waveforms
10B

46B

Overview

Accessing
menus

Up to four waveforms can be stored in and
recalled from the GDS‐122 internal memory. The
stored waveform can be used for reference,
comparison, or analysis.

The following menu trees are
accessible by pressing the MENU
key followed by Up/Down keys,
except for the OSC OPTION key
(page60).

MENU

180H

Memory

Four memories: waveform A, B, C, and D.

Source

CH1, CH2, Math waveform

Trigger
47B

Panel operations 1. Press the MENU key and

select the WAVE SAVE menu
using the Up/Down keys.

MENU

RUN/STOP

WAVE SAVE

TRIG MODE

AC
LF Rjc
HF Rjc

Rising

CH2

Auto
Normal

Edge
TYPE

Falling
Slope

CH1
Source

Single
Mode

DC
Coupling

F1

F2

F3

F4

F5

Inverted

CH2

Field

2. Press F2 (Wave) repeatedly
and select the waveform you
want to recall.

A
Wave

3. Press F4 to turn on the
waveform. The waveform
appears in the display.

OFF
Show

Video
TYPE

Normal
Polarity

CH1
Source

Line
Sync

F4

F1

F2

F3

F4

F2

Select run or stop mode

RUN/STOP key

Select edge or video trigger

TRIG MODE→F1(TYPE)

Select trigger slope

TRIG MODE→F1(edge)→F2(Slope)

Select trigger source

TRIG MODE→F1→F3(Source)

Select trigger mode

TRIG MODE→F1(edge)→F4(Mode)

Select trigger coupling

TRIG MODE→F1(edge)→F5(Coupling)

Select video polarity

TRIG MODE→F1(video)→F2(Polarity)

Select video line sync

TRIG MODE→F1(video)→F4(Sync)

CH1/CH2 Setup
48B

Note

CH1 SETUP

The recalled waveform maintains its original
horizontal scale and vertical scale, which are
shown in the top left corner of the display.
Changing the current scale does not affect the
recalled waveform’s shape.

CH2 SETUP

DC
Ground

OFF

AC
ON
Coupling Channel
F1

F2

Select AC, DC, or Ground coupling

55

56

1000 X
100 X
10 X

ON

1X
Probe

OFF
Inverted

F3

F4

CH1/2 SETUP→F1(Coupling)

Using the Oscilloscope
Turn CH1 on or off

CH1/2 SETUP→F2(Channel)

Select probe scaling

CH1/2 SETUP→F3(Probe)

Turn inversion on or off

CH1/2 SETUP→F4(Inverted)
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Acquisition Mode
52B

4
128
64

Measurement Setup 1/2
49B

MEAS SET1
MEAS SET2

CH2
CH1

CH2
CH1

CH2
CH1

CH2
CH1

CH2
CH1

Freq

Period

Mean

PK-PK

Cyc RMS

F1

F2

F3

F4

F5

Measure CH1/CH2 frequency

MEAS SET1/2→F1(Freq)

Measure CH1/CH2 period

MEAS SET1/2→F2(Period)

Measure CH1/CH2 mean value

MEAS SET1/2→F3(Mean)

Measure CH1/CH2 peak to peak time

MEAS SET1/2→F4(PK-PK)

Measure CH1/CH2 cycle

MEAS SET1/2→F5(Cyc RMS)

ACQU MODE

Sample

Peak
Detect

Average

16
Averages

F1

F2

F3

F4

Select sampling mode

ACQU MODE→F1(Sample)

Select peak detect mode

ACQU MODE→F2(Peak Detect)

Select average mode

ACQU MODE→F3(Average)

Select average number

ACQU MODE→F3→F4(Averages)

Time Mode
53B

TIME MODE

Main
Zone
TimeBase Window
F1

Wave Math

F2

Window
F3

50B

WAVE MATH

TIME MODE→F1(Main TimeBase)

Set window zoom width

TIME MODE→F2(Zone Window)

Zoom window

TIME MODE→F3(Window)

CH1-CH2 CH2-CH1 CH1+CH2 CH1*CH2 CH1/CH2

Select main timebase

F1

F2

F3

F4

F5

Subtract CH2 from CH1

WAVE MATH→F1(CH1-CH2)

Subtract CH1 from CH2

WAVE MATH→F2(CH2-CH1)

Add CH2 to CH1

WAVE MATH→F3(CH1+CH2)

Multiply CH2 with CH1

WAVE MATH→F4(CH1*CH2)

Divide CH1 by CH2

WAVE MATH→F5(CH1/CH2)

Function
54B

FUNCTION

CURS MEAS

CH2

OFF
Type

CH1
Source

F1

F2

Autocalibration

F1

F2

Recall factory settings

FUNCTION→F1(Recall Factory)

Run self calibration

FUNCTION→F2(Autocalibration)

Cursor Measurement
51B

Time
Voltage

Recall
Factory

Display
5B

Activate cursor measurement

CURS MEAS→F1(Type)

Select source channel

CURS MEAS→F2(Source)

DISP SET

57

58

Dots

Infinite
5 sec
2 sec
1 sec

XY

Vectors

Vectors
Type

OFF
Persist

YT
Format

Bitmap
Carry

F1

F2

F3

F4

Using the Oscilloscope
Select line display

DISP SET→F1(Type)

Select persistency

DISP SET→F2(Persist)

Select display format

DISP SET→F3(Format)

Select display save format

DISP SET→F4(Carry)
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OSC OPTION key
58B

UP

Wave Save

LEFT

56B

WAVE SAVE

Math
CH2

D
C
B

CH1
Source

A
Wave

Save

OFF
Show

F1

F2

F3

F4

RIGHT

DOWN

ON

Select source channel

WAVE SAVE→F1(Source)

Select waveform ID

WAVE SAVE→F2(Wave)

Save waveform

WAVE SAVE→F3(Save)

Turn waveform display on or off

WAVE SAVE→F4(Show)

LEFT/RIGHT - Time
UP/DOWN - CH1 Zero

LEFT/RIGHT - Time
UP/DOWN - CH2 Zero

System Status

LEFT/RIGHT - Time
UP/DOWN - Trig

Horizontal Vertical

F1

F2

Trigger

Misc

F3

F4

Show horizontal settings

SYS STAT→F1(Horizontal)

Show vertical settings

SYS STAT→F2(Vertical)

Show trigger settings

SYS STAT→F3(Trigger)

Show serial number

SYS STAT→F4(Misc)

: CH1/CH2 horizontal position
: CH1 vertical position
: CH1/CH2 horizontal position
: CH2 vertical position

57B

SYS STAT

OSC
OPTION

Press the OSC OPTION key repeatedly. The
menu message appears in the lower half of
the display and the functionalities of four
keys, UP, DOWN, RIGHT, LEFT, change
accordingly.

: CH1/CH2 horizontal position
: Trigger vertical position

LEFT/RIGHT - Time Base
UP/DOWN - CH1 Volts\Div

LEFT/RIGHT - Time Base
UP/DOWN - CH2 Volts/Div

: horizontal scale
: CH1 vertical scale
: horizontal scale
: CH2 vertical scale

(Math mode)
– Time
– CHMath
Volts/Div
(Cursor mode)
– Time
– Cursor 1/2

59

60

(Math mode)
: Math horizontal position
: Math vertical position
(Cursor mode)
: CH1/CH2 horizontal position
: Cursor 1/2 vertical position
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Installing the software

1B

Overview

Software
functionalities

Software
operations

The GDS‐122 PC software, included in the CD‐
ROM, allows you to view the waveforms in your
familiar PC environment – large display and
mouse operation. Multiple cursors provide flexible
waveform measurements.

PC requirements •
•
•

Windows 2000 or XP
20MB hard drive space
USB host port x 1

Installation steps 1. Activate the Setup.exe file in the

CD‐ROM.

The PC software can run the following
measurement and actions.
• Viewing real‐time updated waveforms
• Running up to 6 cursor measurements
• Measuring period/frequency/pk‐pk voltage
• Printing out waveform images
• Saving and recalling waveform shape and data

2. The language selection window appears. Select
the software language and click OK (you can
later change the language manually).
English

Simplified Chinese

The following is the list of software operations
described in this chapter.
•

Installing the software

page62

•

Modifying, reinstalling, or
uninstalling the software
Connecting the GDS‐122
Configuring the screen
Viewing waveforms
Measuring waveforms
Saving waveforms
Recalling waveforms
Printing out waveforms
Accessing the Help

page64

•
•
•
•
•
•
•
•

Note

59B

18H

182H

page65
page68
page69
page75
page75
page77
page80
page82
183H

3. The software starts preparing the installation.
When the welcome window is displayed, click
Next and start installing the software to your
PC.

184H

185H

186H

187H

18H

189H

190H

The PC software is intended for oscilloscope
operations only; it does not include multimeter
operations.

4. The customer information window will appear.
Enter the user name and organization name.
Select which user will hold the right to access
the software and click Next.

61
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Modifying/Reinstalling/Uninstalling the software
60B

User Name

Overview

After installing the software, you can do the
followings using the same setup file.
• Modifying the software components
• Repairing the software
• Uninstalling the software

Steps

1. Activate the Setup.exe. Follow
the same procedures as
installing the software until the
Program Maintenance window
appears.

Organization

Administration

5. Change the installation directory if necessary
and click Next.

6. Click Install to start installing the software.

7. The software installation automatically starts
and ends. Click Finish to complete installation.

2. Select the action – Modify the software
components, Repair the software, or Remove
(uninstall) the software – and click Next.
Proceed according to the instructions.
Shortcut for
uninstall

Installing the software is completed
63
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Alternatively, you can select the Uninstall
DC_Wave from the program startup menu to
uninstall the software.

Using the Oscilloscope
Activating the
GDS-122

Activating the software and connecting the GDS-122
61B

Overview

Activating the
software

GDS-122 User Manual
1. Power up the GDS‐122 and activate the
oscilloscope screen.
2. Connect an input signal to CH1 and make sure
that the waveform is shown appropriately on
the GDS‐122 display.

Activate the software and connect the GDS‐122 to
it properly by going through these steps,
described in the paragraphs that follow.
1. Activating the software and configuring the
communication port
2. Activating the GDS‐122 and configuring the
data format
3. Connecting them together and if necessary,
installing the USB driver
4. Acquiring waveform data to confirm that the
communication is being secured

3. Open the DISP SET menu and press F4 (Carry)
to select the format of the waveform data sent
from the GDS‐122 to the software.
Vectors
MENU

DISP SET

Bitmap
Carry
F4

1. Open the software by
selecting DS_Wave.exe
from the startup menu.

Vectors Vectored data of the waveform.

Always select the vector format when
viewing the waveform in the software.

Bitmap

2. Select Communications –
Ports Settings from the
menu or click the Ports‐
settings icon on the
Toolbar.

Connecting the
cable

Make sure that USB connection is being
selected. The baud rate, stop bit, data bit, and
parity settings are fixed.

Bitmap image of the display. Select the
Bitmap format only when taking the
bitmap snapshot of the GDS‐122
hardware screen.

1. Connect the GDS‐122 to the PC (software) via
the USB cable.
2. Make sure that the USB driver is installed in
your PC by accessing the Device Manager
(Control Panel ‐> System ‐> Hardware tab). The
GDS‐122 should be recognized as a USB hub.

3. If the driver has not been
recognized, install it
manually by selecting
USBDRV Install from the
startup menu.
The driver file is located in the USBDRV folder
in the software directory.
65
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Acquiring data

In the software, select
Communications – Get Data
from the menu. Alternatively,
you may click the Get data
icon, or press the Ctrl + A
key.

GDS-122 User Manual

Configuring the screen
62B

Overview

Acquiring the GDS-122 display snapshot

When the “Bitmap” format is selected in the GDS‐
122 display carry setting, the software acquires the
display snapshot (*.bmp) at the moment. Save the
file in the local folder and use a graphic software
to open and edit it.
Acquiring the GDS-122 waveform

When the “Vectors” format is selected in the GDS‐
122 display carry setting, the software acquires the
waveform data (*.bin) at the moment.

This section introduces how to configure the
following parameters in the software screen
(waveform viewing mode) to optimize the user
interface.
•

Background color

•

Drawing format

•

Grid color
Grid on/off

•

Language
Closing the software

•

•

Screen overview
Tool bar
& Icons
CH1

1. The waveform data will be stored in the PC
memory to allow to be recalled later (page79).
Edit the location and click Start.

Cursor type

19H

CH2

Horizontal
scale
Vertical scale
Measurement
result
Model name

Waveform
list
File
location

2. The waveform appears in the software screen.

Changing the
background
color

To change the background color,
select View > Background Color
from the menu and select the
new color from the color palette
that appears. Alternatively, you
can also double click inside the
screen to call the color palette.
Black background

Connecting the GDS-122 to the software is completed
67

68

White background

Using the Oscilloscope
Turning the grid To turn on or off the grid, select
on or off
View > Grid lines from the menu

GDS-122 User Manual
Changing the
language

or click the Gridlines icon.

You can select the language from English (default)
or Simplified Chinese. Select Language > English
(Chinese) from the menu. The Language menu
itself always stays as English.
English

Grid on

Changing the
grid color

Changing the
waveform
drawing format

Grid off

Make sure the grid is already
turned on. Select View > Grid
Color from the menu and select
the new color from the color
palette that appears.
Blue grid

Closing the
software

White grid

You can select how the waveform is being drawn
from two formats, line and dots. Select Format >
Data Line (Point) from the menu or click the icons.
Line

Chinese

Point

69
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You can close the software in one of the following
ways. The screen configurations will be retained
the next time you open the software.
•

Pressing the Alt + F4 keys

•

Selecting File > Exit from the
menu

•

Clicking the Close icon at the
top right corner of the software

Using the Oscilloscope
Refreshing the
waveforms

Viewing the waveforms
63B

Overview

GDS-122 User Manual

This section introduces how to modify the
waveform settings for better viewings.
•
•
•
•
•
•

Selecting the displayed waveforms
Refreshing the waveforms
Selecting the active waveform
Changing the waveform positions
Changing the waveform scales
Viewing the automatic measurement results

In the software, select
Communications – Get Data
from the menu. Alternatively,
you may click the Get data icon,
or press the shortcut keys, Ctrl +
A.

Selecting the
Waveform scale settings and automatic
active waveform measurements are done on the active waveform.

1. Click on the waveform name in the bottom left
corner of the screen.
(CH1 selected as the active waveform)

Screen overview

CH1

2. The following locations changes into the
selected channel (example: CH1).

CH2

Horizontal
scale
Vertical scale

Waveform
list

Colored channel label (at the
left side of the screen)

•

Cursor, Time base, Voltage
settings (at the right side of
the screen)

•

Automatic measurement
results (at the bottom right
corner of the display)

Measurement
result
Active waveform

Selecting the
displayed
waveforms

•

In the left bottom corner of the screen, put a
checkmark in the waveform that needs to appear.
Maximum six waveforms are available: CH1, CH2,
A, B, C, D. Waveforms A to D have to be stored in
the GDS‐122 hardware beforehand (see page54 for
details).
192H

Changing the
waveform
positions

(CH1, CH2 selected)

71
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Changing the horizontal position

1. Move the mouse over the waveform until the
mouse icon changes into a left‐right arrow.

Using the Oscilloscope
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Changing the vertical scale

2. Hold the mouse and drag the waveform
sideways.

Select the vertical scale using
the list at the right side of the
screen. You can select the scale
either by searching in the Scale
column or by clicking the
Position arrows.

Changing the vertical position

Click the channel label at the left side of the
waveform and drag the waveform up or down.

Changing the
Before changing the scales, make sure that the
waveform scales correct waveform is selected (highlighted) in the

Viewing the
automatic
measurement
results

Before viewing the measurement results, make
sure that the correct waveform is selected
(highlighted) in the lower left corner of the screen
(example: CH1).

lower left corner of the screen (example: CH1).

The measurement result
is updated in the lower
right corner of the
screen. Three parameters
are listed.

Changing the horizontal scale

Select the horizontal scale using
the list at the right side of the
screen. You can select the scale
either by searching in the Scale
column or by clicking the
Position arrows.

•

Period: measures the waveform period in ms.

•

Freq: measures the waveform frequency in
kHz.
PK‐PK: measures the peak to peak voltage in V.

•
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•

Using the cursor measurements
64B

Overview

Viewing the
cursor
measurement
results

This section introduces how to use cursor
measurements in the software screen.
•
•
•

Activating the cursors
Viewing the cursor measurement results
Moving the cursors

Screen overview
Vertical cursor

All: both the horizontal and
vertical cursors appear.

The cursor measurement
results are updated in the
right side of the screen.
• dy: the voltage difference
between y1 and y2 cursors
• y1, y2: voltage cursors 1
and 2
• dx: the time difference
between x1 and x2 cursors
• x1, x2: time cursors 1 and 2
dx

Measurement
result
Horizontal
cursor

0.0s x1

x2

Cursor type

y1
dy 0.0V
y2

Activating the
cursors

Before activating the cursors, make sure that the
correct waveform is selected (highlighted) in the
lower left corner of the screen (example: CH1).

Moving the
cursors

Move the mouse over the cursor until the mouse
icon changes into a left‐right arrow. Hold the
mouse and drag the cursor sideways (horizontal
cursor) or vertically (vertical cursor).

Select the cursors from the list in the right side of
the screen.
•

None: the cursor is turned off.

•

Horizontal: the horizontal
cursors appear.

•

Vertical: the vertical cursors
appear.

The cursor measurement result changes
accordingly.
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3. Select the data to be saved from
the Save column.
• sequence: the identification
number for each data point
• ch1/ch2: CH1 and CH2 waveform
data
• A/B/C/D: the waveforms stored
in the GDS‐122 hardware
memory

Saving waveforms
65B

Overview

You can save the waveforms into the PC in two
ways. For details of recalling them, see page79.
• Storing waveform data (*.bin file, for viewing
in the software)
• Storing data points (*.txt file, for data analysis
such as in graphs and maps)
For details of storing waveforms into the GDS‐122
hardware, see page54.
193H

Data points stored in an Excel sheet (example)

194H

Storing
waveform data

When retrieving waveform data from the GDS‐
122, the waveform data (*.bin format) is
automatically stored. For details, see page69.

sequence ch1 / ch2

A/B/C/D

195H

Storing data
point

1. Make sure that the waveform is being
displayed in the screen. To recall waveforms
that are stored in the PC, see page79.
196H

2. Select View > Data Table from the
menu, or click the Data Table
icon on the Toolbar. The Data
Table dialogue appears.

4. Click the Save As… button to
save the data into a directory. The
standard Save dialog appears.
5. To close the Data Point dialogue, do one of the
following actions.
• Press the Ctrl + Alt key

Save option

Save data
Close window

77
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•

Click the Exit icon

•

Click the Close icon at the top
right corner of the dialogue
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Recalling waveforms

Printing out waveforms

6B

Overview
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67B

You can recall the waveforms from the PC in two
ways. For details of saving them, see page77.
• Recalling waveform data (*.bin file, for viewing
in the software)
• Recalling data points (*.txt file, for data
analysis such as in graphs and maps)
For details of recalling waveforms into the GDS‐
122 hardware, see page55.

Overview

You can print out the screen contents to a printer
connected to the PC. When you are printing the
waveform for the first time, follow all the steps in
the following order.
1. Setting up the printer
2. Setting up the page format
3. Printing out

Setting up the
printer

1. Select File > Printer Setup
from the menu. The standard
printer setting dialogue
opens.

197H

198H

Recalling the
waveform data

1. Select File > Open from the
menu or press the shortcut
key, Ctrl + O.
2. The File Open dialogue opens. Select one of the
SPB bin file (*.bin) and click OK.
3. The waveform(s) will be recalled in the screen.

2. Select the printer and its properties, paper size,
and orientation.
Setting up the
page format

1. Select File > Page Setup from
the menu. The Page Setup
dialog window opens.

Borderline

View Setting

Recalling the
data points

1. For recalling the data points, you need to open
a text editor or a spreadsheet program like
Excel, in which you can organize the data and
create graphs and maps for advanced analysis.
2. Open the saved *.txt file from the application.
2. Set the borderlines (print margins). The range
is 0 to 10.0cm each.
79
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3. Select the View Setting.

Accessing the Help
68B

Redraw graph according to sample data:

The GDS‐122 refreshes the waveform and
adjust its scale before printing. The most recent
data can be taken, but might take time for
refreshing.
Graph zoom in and out

Overview

The Help file describes how to install and use the
software. The About screen shows the software
version.

Opening the
Help

Open the Help in separate file using one of the
following methods.

The existing waveform is used with its scale
adjusted. Since retrieving the data is not
involved, fast printing is ensured.
4. Open the print preview by
selecting File > Print Preview
from the menu or clicking the
Print Preview icon on the
toolbar. Make sure that the
waveforms are placed
appropriately.
Printing out

•

Selecting Help > Help from the
menu

•

Clicking the Help icon on the
Toolbar

•

Pressing the shortcut key, F1

•

Selecting the Help documentation from the
startup menu

Print out the waveform in one of the following
ways.
•

Selecting File > Print in the
Print Preview screen menu

•

Selecting File > Print from the
software menu

•

Pressing the shortcut keys, Ctrl + P

•

Clicking the Printer icon on
the Toolbar

Software version To view the software version,

select Help > About from the
menu. The software version
screen appears.
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Activating the Multimeter

USING THE
12B

Panel operations 1. Press the power switch. The

welcome screen with the corporate
logo appears on the display.

MULTIMETER

2. To adjust display brightness, use
the switch on the side: up (bright)
or down (dark).
(Example)
3. Press any key (example: MENU
key) to activate the display. The
battery icon at the top left corner of MENU
the display shows the battery level.

This chapter describes the multimeter
functionalities in the GDS‐122. Functionalities
includes three major items (Voltage, Current,
Impedance) and three additional items (Diode,
Continuity, Capacitance). The current
measurement and capacitance measurement use
extension modules to deal with large current and
small capacitance, respectively. Delta
measurement and automatic range switching
features offer flexibility and convenience.

> 75%

75%

50%

25%

4. Press A (current), V (voltage), or R
(impedance, diode, continuity,
capacitance) switch to proceed. A
warning message might appear to
remind you of correct connections.

Activating the Multimeter ......................................... 8 4
19H

Measuring Voltage ................................................... 8 5

< 25%

A
V
R

20H

Measuring Current ................................................... 8 7
201H

Measuring Impedance .............................................. 8 9
20H

Measuring Diode ..................................................... 9 1

Plug the Multimeter
test leads in the
right position!

203H

Measuring Continuity ............................................... 9 2
204H

Measuring Capacitance ............................................ 9 3
205H

(Press any key to make sure)

5. Press any key to cancel the warning message
and resume the measurement.
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Auto ranging

13B

Range
DC voltage
specifications
Accuracy
(details: page98)
Max input

400mV, 4V, 400V

Range
AC voltage
specifications
Accuracy
(details: page98)
Max input

4V, 40V, 400V

206H

207H

Frequency

±(1% + 1 digit)
400V

Manual ranging

±(1% + 3 digits)
400V
40Hz to 400Hz

Panel operations 1. Press the V switch to select the

Freezing the
measurement

Voltage measurement. If a warning
message appears, press any key to
resume measurement.

V
V

Auto/Manual
range

-83.60mV

DCV/ACV

Delta
measurement
result

1. Press F2

AUTO

To select the voltage range manually,
press F1 (Manual). The indicator at the
top left corner of the display changes
to MANUAL.

Manual

To freeze the measurement, press the
RUN/STOP key. The measurement
result will be retained and the
indicator at the top right corner of the
display changes to STOP. To unfreeze,
press the RUN/STOP key again.

RUN/STOP

F1
MANUAL

RUN
STOP

Measurement
result
F1-F3 menu

AUTOSET

4. Connect the test leads to the
terminals:
COM for the black lead
V/Ω/C for the red lead
5. The measurement result will be constantly
updated in the display. For more detailed
settings, see the following instructions.
85

2. Measurement
reset to zero

3. Delta value
displayed
200.0V

Scaling factor

3. Press the AUTOSET key
repeatedly to select DC or AC
voltage measurement.

F3

moment moves to the top right corner
of the display, and the measurement
result becomes the difference between
the original result.

Run/Stop

Measurement
unit
Meter

Auto

Measuring delta To measure the delta value, press F2
voltage
(II/Δ). The measurement result at the

2. The voltage measurement screen appears.
Battery level

To let the GDS‐122 select the voltage
range automatically, press F3 (Auto).
The indicator at the top left corner of
the display changes to AUTO.
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Measuring Current

2. Select automatic range by
pressing F3 (Auto) or manual
by F1 (Manual). The indicator
at the top left corner of the
display changes accordingly.

14B

DC current
Range &
specifications
Accuracy
(details: page98)
208H

Max input
AC current
Range &
specifications
Accuracy
(details: page98)
209H

Max input

40mA ±(1% + 1 digit)
400mA ±(1.5% + 1 digit)
20A ±(3% + 3 digits)
400mA (direct input)
20A (via the extension module)
40mA ±(1.5% + 3 digits)
400mA ±(2% + 1 digit)
20A ±(5% + 3 digits)
400mA (direct input)
20A (via the extention module)

Panel operations 1. Press the A switch to select the

Auto/Manual
range

A

Freezing the
measurement

Delta
measurement
result

DCA/ACA

Measurement
unit
Scaling factor

Meter

Measuring 0mA
to 400mA

1. Connect the test leads to the
terminals:
COM for the black lead
mA/A for the red lead

(red)

If the range is set at 20A,
press F4 (mA) and change it
to mA range.

MANUAL

AUTO

400mA
MAX

mA/A

COM

20 AMP

(black)

20A
F5

To freeze the measurement, press the
RUN/STOP key. The measurement
result will be retained and the
indicator at the top right corner of the
display changes to STOP. To unfreeze,
press the RUN/STOP key again.

MANUAL

RUN/STOP
RUN
STOP

moment moves to the top right corner
of the display, and the measurement
result becomes the difference between
the original result.

F1-F5 menu

AUTOSET

F3

Measuring delta To measure the delta value, press F2
current
(II/Δ). The measurement result at the

Measurement
result

2. Press the AUTOSET key
repeatedly to select DC or
AC current measurement.

F1

2. Press F5 (20A) and select the
20A range. The MANUAL
range indicator activates.
(Auto range is not available)

Run/Stop

-83.60mA

1. Connect the Current
Extension module to the
COM & mA/A terminals.
Then, connect the test leads
to the extension module.

Auto

(red)

A

current (Ampere) measurement. If
a warning message appears, press
any key to resume measurement.

Battery level

Measuring
400mA to 20A

Manual

1. Press F2

2. Measurement
reset to zero

3. Delta value
displayed
20.0mA

mA/A

(black)
400mA
MAX

COM

mA
F2

20A

mA
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Manual ranging

15B

Impedance
Range &
specifications
Resolution
(details: page98)
210H

400Ω ±(1% + 3 digits)
4k, 40k, 400k, 4MΩ ±(1% + 1 digit)
40MΩ ±(1.5% + 3 digits)

Freezing the
measurement

Panel operations 1. Press the R switch. If a warning

message appears, press any key to
resume measurement.

2. Press the AUTOSET key repeatedly
to select the impedance
measurement.

AUTOSET

To select the voltage range manually,
press F1 (Manual). The indicator at the
top left corner of the display changes
to MANUAL.

Manual

To freeze the measurement, press the
RUN/STOP key. The measurement
result will be retained and the
indicator at the top right corner of the
display changes to STOP. To unfreeze,
press the RUN/STOP key again.

RUN/STOP

F1
MANUAL

RUN
STOP

Measuring delta To measure the delta value, press F2
impedance
(II/Δ). The measurement result at the

moment moves to the top right corner
of the display, and the measurement
result becomes the difference between
the original result.

3. The impedance screen appears.

1. Press F2

2. Measurement
reset to zero

3. Delta value
displayed
120.0kO

4. Connect the test leads to the
terminals:
COM for the black lead
V/Ω/C for the red lead
5. The measurement result will be constantly
updated in the display. For more detailed
settings, see the following instructions.
Auto ranging

To let the GDS‐122 select the voltage
range automatically, press F3 (Auto).
The indicator at the top left corner of
the display changes to AUTO.

Auto
F3

AUTO
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Measuring Diode

Measuring Continuity

16B

Range

17B

Conditions

0V to 1.5V

Panel operations 1. Press the R switch. If a warning

message appears, press any key to
resume measurement.

2. Press the AUTOSET key repeatedly
to select the continuity
measurement.

AUTOSET

3. The diode measurement screen appears.
Battery level

AUTOSET

3. The continuity measurement screen appears.

Run/Stop

Run/Stop

Battery level

Manual range

Manual range

Diode

Continuity

Measurement
unit

Measurement
unit

Scaling factor

Meter

Meter

Measurement
result
F1-F3 menu
(not used)

Measurement
result

4. Connect the test leads to the
terminals:
COM for the black lead
V/Ω/C for the red lead

5. The measurement result will be constantly
updated in the display.
To freeze the measurement, press the
RUN/STOP key. The measurement
result will be retained and the
indicator at the top right corner of the
display changes to STOP. To unfreeze,
press the RUN/STOP key again.

Scaling factor

F1-F3 menu
(not used)

4. Connect the test leads to the
terminals:
COM for the black lead
V/Ω/C for the red lead

Freezing the
measurement

< 50Ω (beeping)

Panel operations 1. Press the R switch. If a warning

message appears, press any key to
resume measurement.

2. Press the AUTOSET key repeatedly
to select the diode measurement.

GDS-122 User Manual

5. If the GDS‐122 confirms continuity (the
impedance is less than 50Ω), the beeper
sounds.

RUN/STOP

Freezing the
measurement

RUN
STOP
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To freeze the measurement, press the
RUN/STOP key. The measurement
result will be retained and the
indicator at the top right corner of the
display changes to STOP. To unfreeze,
press the RUN/STOP key again.

RUN/STOP
RUN
STOP

Using the Multimeter

Measuring Capacitance

Freezing the
measurement

18B

Continuity
specifications

Range

GDS-122 User Manual

51.2nF to 100uF ±(3% + 3 digits)

Panel operations 1. Press the R switch. If a warning

message appears, press any key to
resume measurement.

2. Press the AUTOSET key repeatedly
to select the capacitance
measurement.

1. Press F2

Delta
measurement
result

Capacitance

Scaling factor
Measurement
result

F1-F3 menu
(F1, F3 not
used)

Measuring 5nF
and above

Connect the test leads to the CX
terminals.

Measuring less
then 5nF

Connect the Capacitance
Extension module to the COM
& V/Ω/C terminals. Then,
connect the test leads to the
extension module. The
measurement result will be
constantly updated in the
display.

CATII
400V

COM

STOP

CX

400V
400V
MAX

V/O/C

CX <5nf
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2. Measurement
reset to zero

3. Delta value
displayed
59.6nF

Measurement
unit
Meter

RUN

moment moves to the top right corner
of the display, and the measurement
result becomes the difference between
the original result.

Run/Stop

Auto range

RUN/STOP

Measuring delta To measure the delta value, press F2
capacitance
(II/Δ). The measurement result at the

AUTOSET

3. The capacitance screen appears.
Battery level

To freeze the measurement, press the
RUN/STOP key. The measurement
result will be retained and the
indicator at the top right corner of the
display changes to STOP. To unfreeze,
press the RUN/STOP key again.
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•

Q

A

ERR mode in the Q
multimeter

A

Q
Amplitude
mismatch in the
oscilloscope
A

No waveform in Q
the oscilloscope

•

The GDS‐122 does not power up.

•

The GDS‐122 stopped working after a short
period of time.

A

The battery may need recharging. Connect the
GDS‐122 to the AC adaptor and recharge it for
at least 15 minutes. Then try powering up.
In the multimeter mode, the measurement
type at the top of the display says “ERR”
which looks like an error message.

video, is selected.
Try changing the HF and LF repression in
the trigger coupling mode and filtering out
high or low frequency noise.

The waveform does not appear at all in the
display.
•

•

The trigger level might be out of the
waveform range. Press the AUTOSET key
so that the GDS‐122 automatically adjusts
the trigger level.
If the trigger mode is Single, press the
RUN/STOP key to trigger the waveform or
switch the trigger mode to Normal. See
page30 for trigger details.
213H

Slow update in
the multimeter

The “ERR” sign appears when none of the
measurement switch is pressed. Select one
from the V, A, or R switch and press it.
The measured voltage is 10 times smaller than
the real value.
The attenuation ratio on the probe is set at x10.
If you switch it to x1, make sure that the input
voltage does not surpass the maximum 400V.

Q

The measured voltage is 10/100/1000 times
larger than the real value.

A

The probe ratio in the CH1 or CH2 setup
menu is set at X10, X100, or X1000. See page22
for details.

Q

It takes 30 to 40 seconds for the multimeter to
update the capacitor measurement.

A

It takes longer time to measure small
capacitors. 30 to 40 seconds are normal for
measuring 5nF or smaller capacitors. See
page93 for capacitance measurement details.
214H

Q
Slow update in
the oscilloscope
A

The display response to the waveform change
is unusually slow.
Slow response is normal in the following
cases.
• Average sampling mode is being selected
(page22)
• Display persistence is being selected
(page36)
215H

21H

Q
Unstable
waveform in the
oscilloscope
A

216H

The waveform appears in the display but is
not stable.
Configuring the trigger might help you. See
page30 for details.
• Make sure the trigger source channel
matches the input signal.
• Make sure the correct trigger type, edge or
21H
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Trigger

SPECIFICATIONS
Conditions for
specifications

The following specifications are applicable when
these two conditions are met:
• The GDS‐122 has been powered up for at least
30 minutes, during which temperature
fluctuation is no more than 5 degrees Celsius.
• The probe attenuation is set to X 10.

Measurement

Horizontal

DC coupling: ≥ 50Hz.
±6 divisions from the screen center
±0.3 div (typical, rise/fall time ≥ 20ns)

Displacement

655div (pre-trigger), 4div (post- trigger)

50% level setting

Input signal frequency ≥ 50Hz (typical)

Trigger sensitivity

2 div of peak-to-peak (video trigger)

Signal system

NTSC, PAL, SECAM (any frequency)

Cursor

△V and △T between cursors

Automatic

Peak-to-peak, average, root mean
square, frequency, and cycle
1X position

10X position

Bandwidth

≤ 6 MHz (DC)

Full bandwidth (DC)

Attenuation rate

1: 1
10pf～35pf

10: 1
10pf～35pf

Compensation

Mode

Normal, Peak detection, Average

Input impedance

1MΩ±2％

Input impendence

85pf～115pf

14.5pf～17.5pf

Coupling

DC, AC

Input voltage

150 V DC

300V DC

Rate

100 MSa/s

Impedance

1MΩ±2% in parallel with 20pF±3pF

Probe

1X, 10X, 100X, 1000X

Max. Input

400V (peak)

Channel delay

150ps (typical)

Sampling rate
Interpolation
Record length
Scanning speed
Sampling rate /

accuracy (full

Multimeter specifications
VDC

10S/s～100mS/s

（sin x）/x
6K points on each channel
5ns/div～5s/div, 1-2.5-5 step

Accuracy

1000V (DC or AC peak-to-peak value)
±1%±1 digit

Resolution

400mV range: 100uV

400V range: 100mV
VAC

reading+0.6ns) Average >16 : ±(1

Sensitivity

8 bits resolution (2CH simultaneously)
5mV/div～5V/div（at input）

Displacement

±50V(500mV～5V),±1V(5mV～200mV)

Bandwidth

20M

Single

Full bandwidth
≥5Hz（at input, AD coupling, -3dB）

DC accuracy (avg)

10MΩ

40V range: 10mV

interval time +100ppm×reading+0.4ns)

DC accuracy

Max input

±100ppm (time interval ≥ 1ms)

bandwidth)

Rise time

Input impedance

4V range: 1mV

A/D converter

Low frequency

10MΩ±2％

70B

relay time accuracy
Interval (△T)
Single: ±(1 interval time +100ppm×

Vertical

Trigger level

Probe

Oscilloscope specifications

Input

CH1 and CH2: 1div(DC～full bandwidth)

Level accuracy

69B

Sampling

Sensitivity

Input impedance

10MΩ

Max input

750V(AC, virtual value)

Frequency range

40Hz~400Hz

Accuracy

Display

Virtual value of sine wave
±1%±3 digits

Resolution

4V range: 1mV
40V range: 10mV
400V range: 100mV

DCA

≤17.5ns (at input, typical)
±5% (DC gain)

Accuracy

40mA range: ±1%±1 digit

Resolution

40mA range: 10uA

400mA range: ±1.5%±1 digit
20A range: ±3%±3 digits

Avg >16: ±(5% rdg + 0.05 div) for △V

97

98

Specifications
400mA range: 100uA

DECLARATION OF

20A range: 10mA
ACA

Accuracy

40mA range: ±1.5%±3 digit
400mA range: ±2 %±1 digit
20A range: ±5%±3 digits

Resolution

CONFORMITY

40mA range: 10uA
400mA range: 100uA
20A range: 10mA

Resistance

Accuracy

400Ω range: ±1%±3 digits

Resolution

400Ω range: 0.1Ω

4kΩ~4MΩ range: ±1%±1 digit
40MΩ range: ±1.5%±1 digit

We
GOOD WILL INSTRUMENT CO., LTD.
(1) No.7‐1, Jhongsing Rd., Tucheng City, Taipei County, Taiwan
(2) No. 69, Lu San Road, Suzhou City (Xin Qu), Jiangsu Sheng, China
declare, that the below mentioned product
Type of Product: Handheld Digital Storage Oscilloscope & Multimeter
Model Number: GDS‐122
is herewith confirmed to comply with the requirements set out in the
Council Directive on the Approximation of the Law of Member States
relating to Electromagnetic Compatibility (89/336/EEC) and Low Voltage
Directive (73/23/EEC).
For the evaluation regarding the Electromagnetic Compatibility and Low
Voltage Directive, the following standards were applied:
◎ EMC

4kΩ range: 1Ω

40kΩ range: 10Ω
400kΩ range: 100Ω
4MΩ range: 1kΩ
40MΩ range: 10kΩ
Capacitance

Accuracy

±3%±3 digits

Resolution

51.2nF range: 10pF
512nF range: 100pF
5.12uF range: 1nF
51.2uF range: 10nF
100uF range: 100nF

Diode

Reading range

0V~1.5V

Continuity

Threshold

< 30Ω

EN 61326‐1: Electrical equipment for measurement, control and laboratory
use –– EMC requirements (1997 + A1:1998 + A2:2001 + A3:2003)
Current Harmonics
Voltage Fluctuations
EN 61000‐3‐2: 2000 + A2:2005
EN 61000‐3‐3: 1995 + A1:2001
‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

General specifications
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Display

Power

Environment

GDS-122 User Manual

Type

Resolution

3.8" color liquid crystal display
320 (horizontal) ×240 (vertical) pixels

Color

4096 colors

Consumption

< 6W

Supply

100V~240V AC, 50/60Hz

DC input

8.5VDC, 1500mA

Operating

Temperature: 0 to 40 °C(32 to 104 °F)

◎ Safety
Low Voltage Equipment Directive 73/23/EEC
Safety Requirements
IEC/EN 61010‐1: 2001 (2nd Edition)

Relative humidity: < 75%
Storage

Temperature: -20 to 60 °C(-4 to 140 °F)
Relative humidity: < 75%

Mechanical

Dimension

18 cm×11.5cm×4cm

Weight

690g
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AC coupling
trigger ............................................. 32
vertical............................................ 24
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specifications ................................. 99
AC‐DC adaptor.................................. 10
acquisition........................................... 35
short cuts........................................ 58
system status ................................. 37
ACV multimeter ................................ 85
specifications ................................. 98
addition, math mode......................... 39
auto ranging
impedance multimeter ................ 89
voltage multimeter ....................... 86
auto trigger mode .............................. 31
AUTO trigger status.......................... 27
automatic measurements ................. 41
shortcuts......................................... 57
Autoset ................................................ 18
capacity multimeter ..................... 93
continuity, multimeter................. 92
diode, multimeter......................... 91
impedance measurement ............ 89
voltage multimeter ....................... 85
average acquisition mode ................ 35
application ..................................... 49
background color, PC software....... 68
battery level ........................................ 16
calibration ........................................... 51
short cuts........................................ 58
capacitance measurement,
multimeter ..................................... 93
specifications ................................. 99
carry, interface setting ...................... 66
carrying case....................................... 10
caution symbol..................................... 6
CD‐ROM ............................................. 10

channel
edge trigger ................................... 31
on/off .............................................. 23
video trigger source ..................... 34
contents of package ........................... 10
continuity, multimeter...................... 92
specifications ................................. 99
coupling
system status ................................. 38
trigger ............................................. 32
vertical............................................ 24
cursor measurement
PC software ................................... 75
short cuts........................................ 57
time ................................................. 42
voltage ............................................ 43
cycle rms, automatic measurement 41
data point, storing ............................. 77
data table, PC software..................... 77
DC coupling
trigger ............................................. 32
vertical............................................ 24
DCA multimeter ................................ 87
specifications ................................. 98
DCV multimeter ................................ 85
specifications ................................. 98
default settings................................... 53
delta measurement
capacitance multimeter ............... 94
current multimeter ....................... 88
impedance multimeter ................ 90
voltage multimeter....................... 86
diode measurement, multimeter..... 91
specifications ................................. 99
display
acquiring snapshot ....................... 67
brightness adjustment ................. 16
overview ........................................ 19
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settings ........................................... 36
shortcuts......................................... 58
specifications ................................. 99
division, math mode ......................... 39
dot drawing ........................................ 36
edge trigger......................................... 30
auto mode ...................................... 31
coupling mode .............................. 32
mode ............................................... 31
normal mode ................................. 32
single mode ................................... 32
EN61000 ............................................ 100
EN61010
declaration of conformity.......... 100
measurement category .................. 7
pollution degree.............................. 7
EN61326‐1 ......................................... 100
environment
operation .......................................... 7
specifications ................................. 99
storage .............................................. 8
ERR mode, multimeter ..................... 95
extension module
capacitance multimeter................ 93
current multimeter ....................... 88
package .......................................... 10
factory settings ................................... 53
FAQ...................................................... 95
ERR mode, multimeter ................ 95
magnification ................................ 95
no waveform ................................. 96
powering up .................................. 95
slow update, multimeter ............. 96
slow update, oscilloscope............ 96
unstable waveform....................... 95
field trigger, video ............................. 34
freezing measurement
capacitance multimeter................ 94
continuity multimeter.................. 92
current multimeter ....................... 88
diode multimeter.......................... 91
impedance multimeter ................ 90
voltage multimeter ....................... 86
frequency, automatic measurement41
front panel overview......................... 12
grid color, PC software ..................... 69

102

grid, PC software............................... 69
ground symbol..................................... 6
help, PC software .............................. 82
Hf Rjc ................................................... 32
horizontal
adjusting position................... 20, 25
adjusting scale......................... 19, 26
scale vs trigger status................... 28
short cuts........................................ 58
specifications ................................. 97
system status ................................. 37
impedance, multimeter..................... 89
specifications ................................. 99
installing PC software....................... 62
inverting channel............................... 24
language
PC software ................................... 70
short cuts........................................ 58
LF Rjc ................................................... 32
line data, PC software....................... 69
line trigger, video .............................. 34
list of features ..................................... 11
magnification, vertical ...................... 25
manual ranging
current multimeter ....................... 88
impedance multimeter ................ 90
voltage multimeter ....................... 86
manual, overview of ......................... 14
math mode.......................................... 39
shortcuts......................................... 57
system status ................................. 38
mean voltage, auto measurement... 41
multimeter
activating ....................................... 84
capacitance measurement ........... 93
continuity measurement ............. 92
current measurement................... 87
diode measurement...................... 91
ERR mode ...................................... 95
impedance measurement ............ 89
specifications ................................. 98
voltage measurement................... 85
warning message .......................... 84
multiplication, math mode .............. 39
noisy signal, viewing ........................ 49
normal trigger mode ......................... 32

Index
operation environment ....................... 7
OSC option key .................................. 60
oscilloscope
specifications ................................. 97
switching to multimeter .............. 16
package contents................................ 10
PC software
activation ....................................... 65
cursor measurement .................... 75
help ................................................. 82
installation ..................................... 62
overview ........................................ 61
package .......................................... 10
printing out.................................... 80
saving waveform .......................... 77
screen overview ............................ 68
uninstall ......................................... 64
version............................................ 82
viewing waveforms...................... 71
peak detect acquisition mode .......... 35
application ..................................... 48
period, automatic measurement ..... 41
persistence setting ............................. 36
application ..................................... 50
pk‐pk voltage, automatic
measurement................................. 41
point data, PC software .................... 69
position
horizontal....................................... 25
math mode..................................... 40
shortcuts......................................... 60
time cursor..................................... 43
trigger ............................................. 28
vertical............................................ 23
voltage cursor................................ 44
waveform, PC software ............... 72
xy mode.......................................... 47
power supply
safety instructions .......................... 7
specifications ................................. 99
power up, faq ..................................... 95
powering up ....................................... 16
print out, PC software....................... 80
probe
adjusting display magnification 17
adjustment tool ............................. 10

calibration ...................................... 52
package .......................................... 10
setting attenuation........................ 17
specifications ................................. 98
Ready trigger status .......................... 27
recalling
default settings.............................. 53
default settings, shortcuts ........... 58
waveforms from GDS‐122........... 55
waveforms, PC software ............. 79
resetting trigger level ........................ 29
run trigger........................................... 28
sample acquisition mode.................. 35
saving
shortcuts......................................... 59
waveforms in PC software.......... 77
waveforms inside GDS‐122 ........ 54
scale
horizontal....................................... 26
math mode..................................... 40
vertical............................................ 23
waveform, PC software ............... 73
xy mode.......................................... 47
zoom ............................................... 46
Scan trigger status ............................. 27
self calibration .................................... 51
SET1/2, automatic measurement..... 41
signal peak, viewing ......................... 48
single trigger mode ........................... 32
slope, trigger....................................... 30
snapshot, display............................... 67
software version ................................ 82
specifications
general............................................ 99
multimeter ..................................... 98
oscilloscope.................................... 97
stop trigger ......................................... 28
STOP trigger status ........................... 27
storage environment ........................... 8
subtraction, math mode.................... 39
synchronization, video trigger ........ 34
system status ...................................... 37
shortcuts......................................... 59
test lead ............................................... 10
threshold, continuity multimeter.... 92
tilt stand .............................................. 17

103

GDS-122 User Manual
time cursor .......................................... 42
Trigʹd trigger status........................... 27
trigger
adjusting level ............................... 28
auto mode ...................................... 31
channel, edge trigger ................... 31
coupling mode .............................. 32
edge triggering.............................. 30
mode ............................................... 31
normal mode ................................. 32
run/stop.......................................... 28
shortcuts......................................... 56
single mode ................................... 32
slope................................................ 30
source channel, video .................. 34
specifications ................................. 98
status icons .................................... 27
status vs horizontal scale............. 28
sync, video trigger........................ 34
system status ................................. 38
video ............................................... 33
UK power cord..................................... 8
USB driver installation ..................... 65
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variations, viewing............................ 50
vector drawing................................... 36
vertical
adjusting position................... 20, 23
adjusting scale......................... 19, 23
inverting channel.......................... 24
selecting coupling mode.............. 24
selecting magnification................ 25
shortcuts......................................... 56
specifications ................................. 97
system status ................................. 38
video trigger ....................................... 33
field trigger .................................... 34
line trigger ..................................... 34
source channel .............................. 34
sync ................................................. 34
voltage cursor..................................... 43
warning message, multimeter ......... 84
warning symbol ................................... 6
xy mode............................................... 47
system status ................................. 37
zoom waveform................................. 45
system status ................................. 37

